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Real-Time Handheld Analyzer

Real-Time Handheld Analyzer SignalShark®, for the De- » Frequency range 8 kHz to 8 GHz
tection, Analysis, Classification and Localization of RF » Wideband frequency monitoring with an extremely fast
Signals between 8 kHz and 8 GHz. Solves complex scan rate of up to 50 GHz/s
measurement and analysis tasks reli- ably and quickly , Covers whole frequency bands with a 40 MHz
with the same RF performance as com- parable desktop real-time instantaneous bandwidth and a very high
instruments. frequency resolution
» FFT overlap at least 75 %
» FFT size: up to 16 384
> Reliable signal detection due to signal duration with
100 % POI
» > 3.125 us without attenuation and spectral growth
» > 1.41 ps with 1Q Analyzer
» > 2 ns with attenuation proportional to the spectral

growth

» Measures weak signals in the presence of strong
transmitters with a receiver based High Dynamic
Range (HDR)

» ITU-compliant measurements and applications

» Two independent FFT and receiver path allowing

signal visualization as well as signal analysis and

demodulation at a time.

» Common used SCPI standard for remote control

» VITA 49 streaming (sample rate up to 25.6 MHz)
allowing storage and post processing of the signal raw
data.

> VITA 49 FFT streaming span up to 40 MHz for over-
view display

» High level accuracy
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Take up the frequency spectrum challenges of today and
tomorrow
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Seven Senses for Signals

Description

Li'ke a Shark, tha.‘t highly efficient hunter in the ocean, Narda More and more devices have to share the available frequen-
SignalShark derives its success in measurement from the

. . X cy ranges because of the rapid development in new technolo-
e e oo st e ey sho 1o U 35 h ntome o hings 1), machin-to-macine
pulsed signals > 3.125us with a POl of 100 %. This (M2M) or car-to-car (C2C) communications and expanding

arantees a consistent awareness of all spectrum events 4G/5G mobile networks. Whether making a wideband
gu . L >! ware . pectrum ev " measurement of an entire fre- quency range, detecting hidden
Due to its distinguished analysis functions as real-time spec-

trum. spectroaram and persistence. measured signals are signals, reliably capturing very short impulses or localizing
» SP 9 P ’ . gn: interference signals, SignalShark provides comprehensive
ana- lyzed with a very high frequency and time resolution.

measurement solutions for the in- creasingly complex RF
spectrum

Applications
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Tasks and Views

Customerapplications have formed the basis for the design of
the SignalShark family and the layout of the graphical user in-
terface (GUI). This is most clearly seen in the concept of Tasks
and Views. All SignalShark devices are supporting the same
GUI. The devices can be accessed with remote desktop
software via a network.

Configure

Tasks

Measurements often consist of a workflow of several steps,
such as locating a signal in the spectrum, measuring its level : .
and analyzing its behavior. This involves switching between 1 i 181 <
dif- ferent measurement modes and settings in each mode [ ' I {8 ¥ A
when a general-purpose analyzer is used. However, with the
SignalShark, the entire measurement work- flow is handled

by one or more measurement tasks. These tasks are shown

as screen tabs, just like the web pages displayed by a web Fig. 1. RT Spectrum view (View 1) and Spectrogram view (View 1)
browser. Each task encapsulates all the measurement @ f@sk(Task2)

parameters and the underlying measurement engine mode.

All the measurements in a task are performed at the same rg|iaply eliminates the influence of false bearings on the local-

time. Up to six measurement visualizations (Views) can be jzation result, as long as there are enough line of sight bearings
added to adapt a task as required. The SignalShark provides 5y zilable from enough locations.

several task modes to support a wide variety
measurement applications.

Traces

Display

Real-TimeStreamingTask

IQ data can be streamed at sample rates of up to 25.6 MHz
using the VITA 49 protocol (option). The stream sink can be
an external device connected via the LAN interface or a third
Spectrum (Scan) Task party application running on the SignalShark itself for deeper
This task supports measurement of the spectrum over the full analy- sis or decoding of signals.

frequency span of 8 kHz to 8 GHz in a single measurement at

a maximum measurement speed of 50 GHz/s. IQ Analyzer Task
IQ Analyzer with 1.6 GB ring buffer, real-time trigger, time do-
Real-Time Spectrum Task main analysis and spectrograms with time resolution down to

Real-Time Spectrum task enables spectrum measurements with nanoseconds. Up to 1.6 GB of IQ data can be continuously re-
a frequency span of up to 40 MHz in real-time. All frequen- cies corded in a ring buffer. This allows recording of a 40 MHz
within the frequency span are acquired simultaneously with no chan- nel over 5 seconds. Narrower channels can be recorded
time gaps and with a FFT frame overlap of 75%. The FFT frame for a correspondingly longer time. Short-term or sporadic
overlap increases to 87.5% for frequency spans of 20 MHz or signals can be detected via various trigger functions. The
less. A second digital down converter is used at the same time recorded values can be displayed simultaneously as a 1Q
for analyzing and demodulating the I1Q data of a sep- arate Spectrum View, IQ Spectrogram View, and a IQ Magnitude
channel within the 40 MHz real-time bandwidth. The fre- quency View. The special feature here is that it is possible to switch

and bandwidth of this channel are selectable. between a high time resolution and a high frequency resolu-
tion even after the measurement. This allows a signal to be
Auto DF Task analyzed in its entire depth. Up to eight markers support the

This task supports the use of the Narda Automatic DF Antenna détermination of signal parameters.

(ADFA). Each bearing cycle can be as short as 1.2 ms and even
the bearings of pulsed signals can be reliably determined as
long as the minimum pulse and gap durations are somewhat
longer than 2 cycle times. The optional available map and lo-
calization functionality, which is integrated into the SignalShark
GUI, allows the reliable localization of transmitters. The sophis-
ticated state of the art algorithm based on the bearing statistics
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“Time-Gated Measurement” (TGM) function

(buit-in in the 1Q Analyzer Task) Time Gaed
“Time-Gated Measurement” enables signals tobe measured T
at specified time slots. For time division multiplex signals like g
TDD, where the uplink and downlink are transmitted on the
same frequency but at different time slots, the function
enables ‘filtering’ to a specific time slot. The time slot can be
defined via the Magnitude view. To use the “Time-Gated j . =
Measurement” function, the options ‘1Q Analyzer, Recorder, [ o PR
Trigger, Magn. View’ and ‘Spectrogram’ are required. " frequendy tGHz | el

“SignalShark 5G Analyzer” (Sk5G) Software

SignalShark 5G Analyzer (Sk5G) is an EMF analysis and mea-
surement software for 5G signals in the FR1 band that can be
installed on SignalShark. It allows the maximum channel field
strength to be extrapolated directly from a 5G ftraffic signal. To
do so, a speed test is initiated on an end device (e.g., smart-
phone). This ensures that the base station directs a traffic beam
with maximum power at the end device. The beam is captured
by the isotropic measuring antenna. The software then records
a spectrogram of the traffic signal for each antenna axis, au-
tomatically selecting the resource blocks with maximum pow- er,
calculating the averaged power per resource element, and then
extrapolating to the maximum possible channel power. The
measurement takes some seconds and runs mostly auto-
matically, significantly reducing the required working time and
eliminating the potential sources of error associated with the
various mechanical measurements that would be needed using
the conventional method. In addition, the software enables an
isotropic measurement of the channel power over time to verify
the smart power lock function of the base station. To use the
software for measurements an isotropic antenna is required.
The options ‘Spectrogram’ and ‘SCPI Remote Control’ and the
option ‘SignalShark 5G Analyzer Measurement’ must as well be
installed on the designated SignalShark. Also need- ed is a 5G-
capable device (e.g. smartphone), to create a traffic beam
directed to the measurement antenna. With the software alone,
without the ‘SignalShark 5G Analyzer Measurement’ option Fig. 3. SignalShark 5G Analyzer Software, 5G EMF Extrapolation
installed, the user can still load and ana- lyze stored view

measurements to evaluate these measurements.

Fig. 2. Time Gated Measurement function in the IQ Analyzer Task
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Views The currently selected view is marked by a blue border. The

Measurements are visualized by means of different views. The content and layout of the “Button Bar” to the right, and the
frequency domain and channel level can be viewed at the same “Measurement Information Bar” at the bottom, depends on
time, for example, by adding a spectrum view and a level meter the cu_rrently selected view. The type, arrgngemgnt and size
view to a measurement task. Up to six views can be added to a ©f @ view can be adapted by the user. It is possible to save

task. As default each new task opens with a Spectrum view. the current configuration and arrangement of Tasks and
Views into setup files.

W @ e o0 e ) -

Tasks and Views

Measurement Engine or Task Mode

Spectrum RT Auto DF RT Q SignalShark
(Scan) (Real-Time) Streaming Analyzer 5G Analyzer
Spectrum

Spectrum U] RT U U
Peak Table (of Spectrum) U] RT ¥
Spectrogram V] RT
Level Meter u
Persistence RT

View Map u .
Bearing
Horizontal Scan a
1Q Magnitude (zero span, scope)
IQ Spectrum
IQ Spectrogram
VITA 49 FFT Streaming
VITA 49 IQ Streaming
5G EMF Extrapolation
5G ‘Smart Power Lock’ Test
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Device Features
Options(Views)andScripts

An extensive setof equipment comprisingfrequency scanner/receiver, transmitter detector, spectrum analyzer, signal analyz-
er, directional antennas, amplifier, compass, triangulation software and maps was usually necessary in order to reliably detect,
analyze and localize RF signals and interference. The SignalShark combines all these functions in one device.

Options (Views)

40 MHz real-time Spectrum, Marker and Peak Table (included in all Basic Sets)

A Panorama scan display that provides extremely fast scanning over the entire frequency
range and is ideal for detecting, monitoring and analyzing any kind of signal.

An ideal complement: Mark suspect signals in the spectrum and save them in a transmitter ta-
ble with relevant parameters such as center frequency, bandwidth, antenna type, and polariza-
tion. This table can then be recalled and worked through successively at each measurement
location and in every operating mode of the instrument.

1Q Analyzer, Recorder, Trigger, Magn. View [option]

In the 1Q Analyzer Task, recorded |Q values can be displayed simultaneously as an 1Q Spec-
trum View, IQ Spectrogram View and IQ Magnitude View. The special feature here is that it

is possible to switch between a high time resolution and a high frequency resolution even
after the measurement. This allows a signal to be analyzed in its entire depth. Therefore it is
optimal when it comes to detection, analysis and documentations of hop ping signals as well
as of interference signals caused by faulty oscillator, welding systems, defective relays or
lamps, jammers etc. It trigger on short pulsed signals down to ns and has a high time resolu-
tion analysis in IQ Spectrogram View and IQ Magnitude View. Up to eight markers support the
determination of signal parameters.

“Time-Gated Measurement” function

The “Time-Gated Measurement” function is a built-in key component of the IQ analyzer,
facilitating precise measurement of signals at designated time slots. For time division multiplex
signals, such as TDD, where the uplink and downlink are transmitted on the same frequency
but at different time slots, the function enables targeted filtering to a specific time slot, enabling
effective interference analysis. The time slot can be defined through the Magnitude View,
allowing for precise control over the measurement process.

Spectrogram [option]

The Waterfall diagram is ideal for long term monitoring of the RF spectrum and for detecting
permanent, sporadic or frequency hopping signals. Transmitters with variable output power
and/or bandwidth can also be identified. Visual representation of the recorded spectra versus
time. Colors represent the signal level. The smallest selectable time resolution is 31.25 ps.
The high resolution makes it possible to display even the frame structures from for services
like UMTS, LTE 5G.

Level Meter incl. Compass values [option]

The option allows you to make selective measurements at a defined frequency (Fcent) e.g. for
monitoring the field strength of a communications channel. The measurement is in real-time and
there are no time gaps. The results are shown from an independent receiver path with steep
channel filters for clean separation of even closely spaced frequencies and has a CBW range
from 25 Hz to 40 MHz for detection and evaluation of pulsed signals (radar) as well as
broadband signals.
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Persistence (of real-time Spectrum) [option]

The Polychrome spectrum displaysspectra as level versus frequency where color indicates
rate of occurrence. Persistence allows sporadic to CW (continuous waveform) signals to be
detected easily. It can also be described as a visual detection of signal under signal, e.g. a

detection of interferers/jammers hidden under a signal.

Automatic DF Antenna Control, Bearing View [option]

Aviewfor Direction finding, showingazimuth,elevation,DF quality, and omnidirectional RMS
level derived from the Narda automatic DF antenna (ADFA). The ADFA elevation is calibrated
between +40° und -20°.

Mapping and Localization [option]

SignalShark simplifieslocalization of transmitters by autonomously evaluating all the available
bearing results and plotting them as a heatmap. It uses a statistical distribution of bearing
lines that represents the uncertainty in the bearing. The result is a map on which the possible
locations of the transmitter are plotted and color-coded according to their probability.

Make a drive test using a vehicle mount-adapter, combine bearings from more than 2 Sig-
nalSharks (NSL Remote DF) or mount the ADFA 2 180° upside down. There are many fea-
tures developed to facilitate and broaden the possibilities for most individual cases.

Analog Demodulation [option]

for signal identification and decoding. AM, Pulse, CW, ISB, USB, LSB, FM, PM, or 1Q signals
can be demodulated with squelch and AGC function. The demodulated signal can be stored
as WAV-file.

Horizontal Scan [option]

plots thesignalstrength versus the angle of incidence on a polar diagram. The display allows
you to more easily see the difference between the received signal and the reflections that
occur. The SignalShark automatically calculates the bearing of the signal source based on the
horizontally measured values.

5G EMF Extrapolation,
The5G EMF extrapolation View allows the maximum channel field strength to be extrapolated
directly from a 5G traffic signal.

A downstream with maximum power is requested using a suitable user equipment (e.g. a
smartphone). The Signal-Shark 5G Analyzer records an isotropic spectrogram and calculates
the average field strength of a 5G resource element as well as the extrapolated maximum

channel field strength.
5G ‘Smart Power Lock’ Test,

The5G Smart Power Lock test feature measures the isotropic channel power of a given 5G
channel over an adjustable time and displays this value as a line graph. It also calculates a
moving average value that can indicate whether the Smart Power Lock function of the given
base station is working correctly.

A downstream with maximum power is requested using a suitable user equipment (e.g. a
smartphone).
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SCPI Remote Control [option]

SCPI(StandardCommandsfor Programmable Instruments) is a language that makes it
possible to control the SignalShark using standard syntax, command structure and data
interchange format. All remote commands are described in Command reference guide for
SignalShark

The SCPI Remote Control allows the Narda Script Launcher to be installed.

VITA 49 [option]

isapacket-based exchange protocol for RF devices. The Vita49 standard provides a commu-
nications format that is hardware and supplier-independent

P Shows the basic measurement parameter settings while streaming 1Q data according to the
Vita 49 standard

IQ Data stream can be used for classification, decoding (3rd party SW) of signals.

Win 10 LTSE
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Narda Python Scripts

NSL (NardaScriptLauncher) isa free software from Narda that allows SignalShark users to select and run Python scripts from
within the SignalShark application. To control the handheld SignalShark analyzer the “Option, SCPI Remote Control” is
required.

» Automate routine tasks

» Provide guided measurements for novices using message boxes or wizards

» Add new measurement evaluation functions

» Provide complete measurement automation

> New scripts constantly released to be downloaded for free

> Possibility to write programs or additions via Python, using a Narda template, customized for specific needs

NSL Remote DF (NSL Net DF)

makes it possible to create a localization with several SignalShark devices in a network.

The user can scan the network to obtain information on all available SignalShark devices,
synchronize all devices with configuration settings of the master device, monitor spectrum re-
ception on all devices simultaneously, and use the bearing information to perform localization
on the master SignalShark device.

NSL Coverage Map
The user can configure settings for the coverage map and take location-dependent level mea-
surements with distinct color-coding.

Drive test for coverage, field strength correlated to color scheme

NSL DF Autopilot

The function allows the SignalShark to be connected to a navigation system. The coordi-
nates determined by the SignalShark heatmap localization are set as target in the navigation
system, thus There is no need to look at the heatmap while driving and only one person is
needed.

NSL Channel Scanner

A memory/frequency scan that makes it possible to monitor predefined channels in the spec-
trum. It is comparable to a channel scan on a radio. If one of the monitored channels exceeds
a definable level value, an action (“Action”) previously defined by the user can be executed.

It is also possible, to scan a frequency grid. This can be used to create a channel table.

NSL Limit Line

enables triggering on signals in the spectrum. The trigger level can be defined by a horizontal
line or by a trigger mask. The trigger mask can be created and edited in the settings editor in
various ways.
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NSL GNSS
displays information about the current GNSS reception and issues a warning message if the
quality of the GNSS reception falls below a certain level.

NSL MS Word

takes a Word (.docx) template file as the basis for a measurement report. It reads all settings
from the current measurement, makes a screenshot of each view and generates a measure-
ment report as MS Word document

NSL Tools

» NSLCopySettings, copies selectable parameters such as Fcent, RBW and Attenuator from
onetasktoanother task.

NSLGo2desktop, emulates the Windows-Key + “D-Key” keytroke to go to the Windows
desktop

NSLSavePeak Table, allows to save the information of a peak table in CSV format.

> NSLIQStream Control, allows to configure and start an |Q stream easily.

> NSLPeaktrigger, uses the peak table view of SignalShark to stop the measurement when
reachingorexceeding a user defined level.

NSLSignalShark WOL, allows to switch on a network connected SignalShark via WakeOn-
LAN.

NSL Converter
ConvertSignalShark Spectrum Data (from HDF5 (.h5) file format to csv file format)

)

> ConvertSignalShark Spectrogram Data (from HDF5 (.h5) file format to csv file format)

> ConvertIDA (csv-based transmitter tables) to SignalShark (xml-based tansmitter tables)

> ConvertSRM (csv-based transmitter tables) to SignalShark (xml-based transmitter tables)

> Converta Template Generated CSV Table (from csv-based transmitter tables to xml-based
transmitter tables)

NSL 1Q Recorder

enables the recording of 1Q data in WAV format.

Allows the user to setup and start/record the 1Q streams by using SignalShark SCPI com-
mands and save them as an IQ WAV file. The WAV file format is a universal format supported
by many monitoring software products and SDR programs.
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Definitions and Conditions

)

Conditions

Unless otherwise noted, specifications apply after 30 minutes warm-
up time within the specified environmental conditions. The product is
within the recommended calibration cycle.

Specifications with limits

These describeproduct performance for the given parameter cov-
ered by warranty. Specifications with limits (shown as <, <, >, 2, +,
max., min.) apply under the given conditions for the product and are
tested during production, considering measurement uncertainty.

Specifications without limits

These describe productperformance for the given parameter cov-
ered by warranty. Specifications without limits represent values with
negligible deviations, which are ensured by design (e.g. dimensions
or resolution of a setting parameter).

narda A

Safety Test Solutions

Typical values (typ.)

These characterize product performance for the given parameter
that is not covered by warranty. When stated as a range or as a
limit (shown as <, £, >, 2, % max., min.), they represent the
performance met by approximately 80% of the instruments.
Otherwise, they rep- resent the mean value. The measurement
uncertainty is not taken into account.

Nominal values (nom.)

These characterize expected product performance for the given pa-
rameter that is not covered by warranty. Nominal values are verified
during product development but are not tested during production.

Uncertainties

These characterize the dispersion of the values attributed to the
measurands with an estimated confidence level of approximately
95%. Uncertainty is stated as the standard uncertainty multiplied
by the coverage factor k=2 based on the normal distribution. The
evaluation has been carried out in accordance with the rules of
the “Guide to the Expression of Uncertainty in Measurement”
(GUM).
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- - - a
Specifications
SignalSharkBasicUnit(40 MHz RTBW)
Frequency
range Scan rate (basic unit, 8 kHz to 8 GHz
full  span) RBW (RT > 50 GHz/s @ RBW = 1.6 MHz (resolution 800 kHz)
Spectrum) RBW  (Scan 30 GHz/s (typ.) @ RBW = 100 kHz (resolution 50 kHz)
Spectrum)  CBW  (Level 1 Hz to 800 kHz
Meter) EMCfitter bandwidtt
—(Specir—umand [P 1 Hz to 6.25 MHz
Dtomtore ! 25 Hz to 40 MHz

(Spectrum and Level Meter) 10 Hz, 100 Hz, 200 Hz, 1 kHz, 9 kHz, 10 kHz, 100 kHz, 120 kHz and 1 MHz

+Pk, RMS, -Pk, Avg and Sample

CISPR Detectors(LevelMeter) Cpeak (quasi-peak), CRMS & CAvg (EMC filter with CISPR bandwidth must be selected
SSB f df =1 kHz df =10 kHz df =100 kHz df =1 MHz df =10 MHz
phase noise 10 MHz <-120dBc (1/Hz) <-130dBc (1/Hz) <-135dBc (1/Hz)

1 GHz <-90dBc (1/Hz)  <-101dBc(1/Hz) <-101dBc(1/Hz) <-112dBc(1/Hz) <-132 dBc (1/Hz)
Internal referencefrequency Deviations: <1 ppm

(includes initial deviation, aging within the first 2 years, and temperature response)

Amplitude
HDR ) SignalShark can detect low level signals even in the presence of very strong signals. It does this by
(High Dynamic Range) combining high sensitivity with a wide intermodulation-free dynamic range.

The DANL and IP2 / IP3 values stated below are valid at the same setting.

DANL (Noise Figure) 1 MHz <f<44 MHz <-160 dB (MW/Hz) (resultant noise figure < 14 dB)
@ attenuator =0dB, 44 MHz <f<3 GHz <-159 dB (mW/Hz) (resultant noise figure < 15 dB)
no preamp 44 MHz < f< 3 GHz - 162 dB (mW/Hz) (typ.) (resultant noise figure 12 dB)
3 GHz <f<8 GHz <-152 dB (mW/Hz) (resultant noise figure < 22 dB)
2" order intercept 4 MAz =f <42 MHZ > 60 dBm
point (IP2, 2 tones) 42 MHz < f< 8 GHz 40 dBm (typ.)
@ attenuator = 0 dB,
no preamp
3rq c:rcliggmztetrcept 3 MHz < f <44 MHz 3 > 20 dBm 26
oin , 2 tones
attonustor - 0, Mz <[44 Mz 44 dem (0p) >
no preamp m > 6
630 MHz < f < 3 GHz dBm 14 dBm
44 MHz < f< 3 GHz 3 (typ) > 5
GHz < f <8 GHz 3 dBm 12 dBm
GHz < f <8 GHz 9 (typ.) < £ 2
Level uncertainty kHz <7< 8 GHz 8 kHz dB < -120
Residual spurs® <1 =44 MHz 44 MHz dBm < -115 exceptions < -100 dBm
@ attenuator = 0 dB <f<3GHz3 GHz <f dBm < -110 exceptions < -100 dBm
<6 GHz6 GHz<f<8 dBm < -105 exceptions < -95 dBm
GHz >80 dB > 80 dB dBm

exceptions < -85 dBm

IF rejection
Image rejection

a RF data apply in the temperature range 20 °C to 26 °C at a relative humidity of between 25 and 75 %
b Component at f1 + f2 is measured in the direct band (Fcent < 64 MHz in real-time mode)
¢ Typically with only few exceptions. These are documented in the calibration certificate
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Real-Time Spectrum
Signaldurationfor100% POI

RT Spectrum @ RBW = 800 kHz
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> 3.125 ps without attenuation and spectral
growth

> 2 ns with attenuation proportional to the spec-
tral growth

1Q Analyzer @ CBW = 40 MHz, RBW = 1.532
MHz and 87.5 % FFT Overlap

> 1.41 ps with 1Q Analyzer

> 2 ns with attenuation proportional to the spec-
tral growth

Spectrum rate

1.6 million spectra /s

@ RBW =800 kHz and 75 % FFT Overlap

FFT overlap Fspan > 20 MHz 75 %
Fspan < 20 MHz, RBW =< 400 kHz 87.5%
Type (switchable) 1 x N-connector, 50 Q (female) 3 x
SMA-connector, 50 Q (female)
RF destruction limit 20 dBm
Max. nominal RF level 15 dBm
Maximum DC voltage 25V
Return loss T2kHz <f< 3 MHz >9.54 dB 12 (VSWR <  2.00)
(VSWR) 3GHz <f<6 GHz dB (typ.) 10 (VSWR = 1.67 (typ.))
6 GHz <f<8 GHz dB (typ.) 60 (VSWR = 1.93 (typ.))
Isolation between used and unused ortle=T=15re dB (nom.) 50
inputs 3 GHz dB (nom.) 35
8 GHz dB (nom.)

General Specifications

Attenuator 0 to 30 dB (0.5 dB steps)
Digitizer 16 bit
GNSS Embedded receiver and antenna (GPS / QZSS, GLONASS, BeiDou, Galileo)

Coordinates representation as decimal degree (DegDec - ddd.ddddd)

Internal non-removable memory

ssD, mSATA

30 GB system partition
28 GB configuration settings and user data

Removable memory

microSD (SDXC)/USB 2.0/ USB 3.0

External power supply

Basic unit, DC input: 10 to 48 VDC

AC adapter, input: 100V-240VAC, output: 12VDC, 5.5A

Plug type: Non-Locking Power Plug S1017

Battery

Inmany countries, the battery is
available from several public distrib-
utors.

2 x Lithium-ion rechargeable battery pack, hot-swappable during operation

Operating time: approx. 3 hours (typical, with both batteries)
Charging time: approx. 4.2 hours (nominal, with both batteries charging in base device)
Charging time: approx. 3 hours (nominal, with external charger)

Dimensions (H x W x D)

230 mm x 335 mm x 85 mm (9.06" x 13.19" x 3.35")

Weight

Approx. 4.1 kg /9.04 Ib (with one battery)

Country of origin

Germany

Recommended calibration interval

24 months
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Interfaces
10MHz Reference input

1 x SMA-connector, 600 Q (female)

PPS/Trigger input

1 x SMA, 100 kQ (female)

GNSS Antenna Input (for additional,
external GNSS antenna)

1 x SMA, 50 Q, female
(DC voltage for active antennas is supplied)

Display Size and Resolution:

10.4%, 1024 x 768 pixels, Color
Resistive touch

Video 1 x Display Port
Audio 1 x 3.5 mm headphone jack
Built-in loudspeaker
Built-in microphone
Ethernet 1 x GigE (10/100/1000Base-T), RJ45
USB (Host) TxUSB 3.0, TxUSB.2.0
SD card slot T x microSD-card (SDXC)

Remote Control and Streaming
Remote control protocol

SCPI

FFT streaming

VITA49 compliant

1Q streaming

VITA49 1Q streaming, sample rate up to 25.6 MHz*

Remote Software

Remote Desktop for PC, Tablet and Smartphone (Windows, Android, IOS)

Additional Functions

Noisepowerdensity measurement

Can be measured with up to eight markers at a time. Can be measured with up to eight markers at a

Channel power measurement

time. According to ITU-R SM.443-4, with additional automatic center frequency and channel power

Occupied bandwidth measurement

mea-
surement. Can be measured with up to eight markers at a time.

Field strength measurement

According to ITU-R SM.378-7

CISPR Detectors

Cpeak (quasi-peak), CRMS & CAvg (EMC filter with CISPR bandwidth must be selected)

Modulation detectors

AM, FM and PM. Up to 4 different detectors are available simultaneously

Frequency offset measurement

For CBW < 1 MHz (using modulation detectors)

Analog demodulation and recording

AM, Pulse, CW, ISB, USB, LSB, FM, PM, or IQ signals can be demodulated with squelch and AGC
function. The demodulated signal can be stored as WAV-file.

Tone search

For PIM and interference hunting. The level of one of the detectors modulates the pitch of an audible
tone.

Automatic DF

Automatic bearing of transmitters using a Narda Automatic DF Antenna.

Automatic transmitter localization
(Heatmap)

Automatic calculation of the transmitter location.

TDOA localization®

Integrated GPS with high-accuracy timestamp for TDOA applications. With additionally available
software package

Time-Gated Measurement (TGM)

Buit-in in the 1Q Analyzer Task. Enables signals to be measured at specified time slots.

5G ‘Smart Power Lock’ Test

Calculates a moving average value that can indicate whether the Smart Power Lock function of the
given base station is working correctly.

d  Applies for integrated 1 Gbit Ethernet interface.

e Requires additional software
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Environmental Conditions

MIL-PRF-28800F Class 2 Operating temperature Storage temperature Operating humidity
Random vibration Functional shock Transit drop -10 °C to + 55 °C
with battery -10 °C to + 55 °C with external power supply
0 °C to + 40 °C with external power supply when charging batteries
<29 g/m® (<93 % RH at +30 °C), non-condensing

IP 54 (with antenna attached and interface protectors closed)
B o ek L N\ 4ren (S cnmad oy e 4o oo
= O7 (SWICU 1T ure Tiarutdst) TR (TEC 0OUTZ T=9) TAICTIUTU U = 2ZU

Operating temperature

O 4o 4 TN OM
CtOT7T0C

(batteries removed)

= 2K4A(EC-66721=3)restricted-to—20-C-to+70°C
Humidity 72 (HEC-60724-3) extended-to—10-C-to—+55-°C
IP cl
class 1M3 (IEC 60721-3)
Climate Storage 2M3SIEC60721-3)
7M3 (IEC 60721-3)
Transport
Operating
Mechanical Storage
Transport
Operating
EMC European Union Complies with RED Directive 2014/53/EU and EN 301 489-1 V2.2.3, EN 301 489-52 V1.2.1 IEC/EN
61326 -1: 2021
Immunity IEC/EN: 61000-4-2, 61000-4-3, 61000-4-4, 61000-4-5, 61000-4-6, 61000-4-11
Emission IEC/EN: 61000-3-2, 61000-3-3, IEC/EN 55011 (CISPR 11) Class B
Safety Complies with European Low Voltage Directive 2014/35/EU and TEC/EN 61010-1:2010
Material Complies with European RoHS Directive 20T1/65/EU, (EU)2015/863 and EN 63000:2018
e ) Vol |
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Ordering Information

The SignalShark Basic Unit is included in theBasic Sets. Application Packages as well as Software Options and Accessories
that provideadditional signal analysis capabilities are also available.
Your local Narda sales representative can provide information about all the possible options and will be pleased to offer advice.

Basic Unit Sets

SignalShark Basic Set Part number

The Basicset contains the SignalShark as well as basic accessories and supports 40 MHz real-time spec- 3310/101
trum analysis, marker and peak table.

Includes:

» SignalShark 3310/01 Basic Unit

» 2x Battery Pack, Rechargeable

» Power Supply 12VDC, 5.5A, 100V-240VAC, plug*

» Touch pen for resistive touch screen

> 40 MHz real-time Spectrum, Marker and Peak Table

» Electronic manual (English)

» Safety Instructions

» SignalShark3310 - QuickStartGuide
*Please choose Power Cord 2260/90.65 -.69
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Application Packages

Theapplication packages make it easy to adapt SignalShark to your requirements. Each package typically consists of applica-
tion-dependent hardware accessories and/or firmware options, and costs less than purchasing the items individually. Additional
packages can be purchased as and when required.

Your local Narda sales representative will be happy to assist you in the selection of the right packages for your applications.

App. Package, Off-Site Extension Part number

ThisApplication Package provides suitable accessories for applications that involve operation in vehicles or 3310/94.07
outdoors. A hard shell case with wheels and a retractable handle provides secure (IP 67) the transport of the
SignalShark and all accessories. The DC adapter enables powering the device from a vehicle. An easily and

quickly worn carry strap provides hands-free support for viewing the SignalShark allowing even long-term
measurements to be made comfortably.

Includes:

> Power Supply DC Vehicle Adapter, screw plug (2259/92.12)

» Double Charger Set, External for 2259/92.16 (2259/92.17)*

Consists of: 2x single bay charger - Charger Set, External (2259/92.14)
» Vehicle power adapter for charger set 2259/92.17 (2259/92.15)
Consists of: Car/Truck Power Adapter (2259/92.18)

Power Splitter Cable (2259/92.19)
» Carrying Strap for Basic Unit (3300/90.08)
> Headphone, 3.5mm Plug (3300/90.14)
» 10.4” Screen Protector Film (3310/90.04)
» Hardcasefor SignalShark 3310 (3310/90.05)
*Please choose Power Cord 2260/90.70 -.74

App. Package, Remote Control Part number

OptionVITA49 requires option SCPI Remote Control for device setup and streaming control. This application 3310/94.10
package makes iteasy to obtain the greatest benefits of SignalShark’s remote control functionality.

Includes:
» Option, SCPI Remote Control (3310/95.012)

> Option, VITA 49(3310/95.14)

App. Package, Receiver Part number
TheReceiver ApplicationPackage guarantees situational awareness by providing gapless analysis of entire 3310/94.01
signalbands. Italsoenablesdemodulation of AM, FM, LSB, USB, and CW signals.

Includes:

» Option, Spectrogram (3310/95.002)

> Option,LevelMeterincl.Compassvalues (3310/95.003)
> Option, Analog Demodulation (3310/95.007)

App. Package, Direction Finding Basic

Part number

ThisApplicationPackage providescomprehensive functions to support hunting of interference signals and 3310/94.02
hidden transmitters. The device based GPS and the antenna handle with built-in electronic compass makes it

possible to conveniently take bearings on a transmitter from various locations.

Includes:

» Active Antenna Handle for SignalShark, 8 kHz to 8 GHz (3300/10)

> Arm Support for Active Antenna Handle (3100/90.10)

» Option, Mapping and Localization (3310/95.006)

> Option, Horizontal Scan (3310/95.011)
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App. Package, Antenna Basic Kit (Mobile Operators)* Part number
This Application Package provides you with a lightweight yet robust directional antenna for the frequency 3106/92.03
range from 400 MHz to 8 GHz and covers cellular communication as well as other service bands. The Pack-

age also includes an antenna adapter that allows you to use your own antennas together with the Antenna

Handle. This enables you to benefit from the integrated compass, low noise amplifier, and automatic polariza-

tion detector in the handle when using your own

Includes:

» Directional Antenna 3, 400 MHz to 8 GHz (3100/13)

> Antenna Adapter, N Male (3100/15)

*Additionaloption 3310/95.006 “Mappingand Localization” isrecommended for Open StreetMapbased visualization and heat-
map localization as well as the Active Antenna Handle for SignalShark, 8 kHz to 8 GHz (3300/10).

App. Package, Antenna Extension Kit Part number

This ApplicationPackage complementsand completes the Antenna Basic Kit Application Package so that you  3106/92.04
can makethe bestuse of the entire frequency rangefrom 8 kHz to 8 GHz.

Includes:

» Directional Antenna 1, 20 MHz to 250MHz (3100/11)

> Directional Antenna 2, 200 MHz to 500MHz (3100/12)

> LoopAntenna,H-Field, 8 kHz to 30 MHz(3100/14)

App. Package, Automatic DF 2, 10 MHz to 8 GHz * Part number

ThisApplicationPackageprovidesbasicequipmentand options for vehicle based, automatic direction finding 3310/94.06
(bearing).

Includes:

> Automatic DF-Antenna 2 (3361/01)

» USB Stick: Software and Manuals, ordered Options (3310/93.01)

> RF-Cable, DC to 8 GHz, N to SMA, 50 Ohm, 5 m (3603/02)

> Option, Automatic DF Antenna Control, Bearing View (3310/95.005)

> Tool, Allen Wrench 3 mm (3300/90.19)

> ADFA Vehicle Mounting Kit for autom. DF Antenna (3300/90.04)

incl. the “Automatic DF-Antenna Handling and Safety Instructions” multilingual (3360/98.12)
» Shipping Carton with Inlet for autom. DF-Antenna
*Additionaloption3310/95.006“MappingandLocalization”’isrecommendedforOpenStreetMapbased visualization and heat-
map localization.

ThisApplicationPackageprovidesbasicequipmentandoptionsfor vehicle based, automatic direction finding 3310/94.12
(bearing).
Includes:

> Automatic DF-Antenna 2 (3361/01)

» USB Stick: Software and Manuals, ordered Options (3310/93.01)

» RF-Cable, DC to 8 GHz, N to SMA, 50 Ohm, 5 m (3603/02)

» Option, Automatic DF Antenna Control, Bearing View (3310/95.005)
» Tool, Allen Wrench 3 mm (3300/90.19)

> ADFA Vehicle Mounting Kit for autom. DF Antenna (3300/90.04)

incl. the “Automatic DF-Antenna Handling and Safety Instructions” multilingual (3360/98.12)
» Hardcase for Automatic DF Antenna (3360/90.01)
*Additionaloption3310/95.006“MappingandLocalization”’isrecommendedforOpenStreetMapbased visualization and heat-
map localization.
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Software Options
Softwareoptionsallowthe adaption of the device feature set to your needs.

Description Part number

40 MHz real-time Spectrum, Marker and Peak Table (included in SignalShark 3310 Basic Set). Included in Basic Set

Via the “Spectrum (Scan)’-, “RT (Real-Time) Spectrum’- “Auto DF’-, and “IQ Analyzer’-Tasks, the following
L

» Peak Table (of Spectrum) View
Option, Spectrogram 3310/95.002

Via the “Spectrum (Scan)’- and “RT (Real-Time) Spectrum’-Tasks, the following View(s) can be accessed:
» Spectrogram View
Option, Level Meter incl. Compass values 3310/95.003

Via the “RT (Real-Time) Spectrum’-Task, the following View(s) can be accessed:
> Level Meter View

Option, Persistence (of real-time Spectrum) 3310/95.004

Via the “RT (Real-Time) Spectrum-Task, the following View(s) can be accessed:
» Persistence View

Option, Automatic DF Antenna Control, Bearing View 3310/95.005

Via the “Auto DF’-Task, the following View(s) can be accessed:
» Bearing View

Option, Mapping and Localization 3310/95.006
Via the “Spectrum (Scan)’-, “RT (Real-Time) Spectrum’-, and “Auto DF’-Tasks, the following View(s) can be
accessed:
> Map View
> Heatmap
> ..
Option, Analog Demodulation (see "Additional Functions” on page 14) 3310/95.007

Via the “RT (Real-Time) Spectrum’-Task, the following View(s) can be accessed:

> Spectrum View

» Level meter View'
Option, Horizontal Scan 3310/95.011
Via the “RT (Real-Time) Spectrum’-Task, the following View(s) can be accessed:

» Horizontal Scan View
Option, SCPI Remote Control 3310/95.012
Option, VITA 49°¢ 3310/95.014
Via the “RT Streaming’-Task, the following View(s) can be accessed:

> VITA 49 FFT Streaming View
» VITA 49 1Q Streaming View

f  Requires Option 3310/95.003 “Option, Level Meter incl. Compass values”
g Requires Option 3310/95.012 “Option, SCPI Remote Control”
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Description Part number
Option, IQAnalyzer, Recorder, Trigger, Magn. View 3310/95.018

Via the “IQ Analyzer’-Task, the following View(s) can be accessed:
> |IQ Magnitude View
» IQ Spectrum View
> IQ Spectrogram View

“Time-Gated Measurement” function is a built-in key component of the 1Q analyzer, facilitating precise mea-
surement of signals at designated time slots.
Option, SignalShark 5G Analyzer Measurement” 3310/95.020

Via the “SignalShark 5G Analyzer’-software, the following View(s) can be accessed:
» 5G EMF Extrapolation View
> 5G ‘Smart Power Lock’ Test View

h  Requires Option 3310/95.002 “Option, Spectrogram” and Option 3310/95.012 “Option, SCPI Remote Control”

! 1 m a C
C"’NSTS 0225-E0328J | SignalShark 3310 Datasheet [Subject to change without notice www.narda-sts.com 20 Qd

WmangEEEI sales@wavetel fr www.wavetel fr +33(0)2 9914 69 65 . m



narda A

Safety Test Solutions

Accessories

Accessory Description Part number

Power Supply 12VDC,5.5A, 100V-240VAC, Non-Locking Power Plug S1017, choose Power Cord 2260/90.65 2259/92.09
-.69

Power Supply DC Vehicle Adapter, screw plug 2259/92.12
Battery Pack Set, rechargeable, Li-lon, 2 x RRC2057, Li-lon, 7V5 , 6.4Ah 2259/92.16
Double Charger Set, external, for 2259/92.16, choose Power Cord 2260/90.70 -.74 2259/92.17
Consists of: 2x single bay charger - Charger Set, External (2259/92.14)
Vehicle power adapter for charger set 2259/92.17 2259/92.15
Consists of: Car/Truck Power Adapter (2259/92.18)
Power Splitter Cable (2259/92.19)
External GNSS Antenna, active 3300/90.05
Touch pen for resistive touch screen 3300/90.07
Carrying Strap for Basic Unit 3300/90.08
RF Adapter, N Male to SMA Female, 50 Ohm 3300/90.13
Headphone, 3.5mm Plug for SignalShark 3300/90.14
Hardcase for SignalShark 3310 3310/90.05
Recovery media for SignalShark Quad Core 3310/90.25
10.4” Screen Protector Film 3310/90.04
Tripod, Non-Conductive, 1.65 m, 1/4”, with Carrying Bag 2244/90.31
Tripod, Non-Conductive, 1.65m, reinforced, 3/8”-16 UNC (for ADFA 2 only) 3300/90.16
Tripod Quick-Release Coupling, 3/8"-16 UNC (for 3300/90.16) 3300/90.17
ADFA Non-Conductive Antenna Mast Mounting Kit 3300/90.23
RF and Control-Cable for Automatic DF-antennas, DC to 8 GHz, N to SMA, 50 Ohm, 5 m 3603/02
RF and Control-Cable for Automatic DF-antennas, DC 1o 8 GHz, N'to SMA, 50 Ohm, 75 m 3603/03
RF and Control-Cable for Automatic DF-antennas, DC o 8 GHz, N to SMA, 50 Ohm, T0 m 3603/07
Antennas* Part number
Directional Antenna 1, 20 MHz to 250 MHz e
Directional Antenna 2, 200 MHz to 500 MHz 3100712
Directional Antenna 3, 400 MHz to 8 GHz 3100113
Loop Antenna, H-Field, 8 kHz o 30 MHz 3100714
~Antenna Adapter, N Vate for Handie 3100710 and 3300710 3100715
—ArmrSupport for Active AntenmaHamdte 3100790.10

Aot I ' for-Si S _gH 8-Gt
Automatic DE-Antenna-2 Basic-Set 10 MHz tc 8 GHZ'
Antenna,Three-Axis, E-Field, 200 MHz to 8 GHz 3502103

*ThereisaseparateDFantennadatasheet,whichprovides detailed information about the direction-findingantennas available
from Narda.

i Requires Option 3310/95.005 “Option, Automatic DF Antenna Control, Bearing View”
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SignalShark Family

There areseveraldifferentinstrument types in the SignalShark family:

SignalShark Handheld, SignalShark Remote Unit, SignalShark Outdoor Unit Modem R[n] Basic Set, SignalShark DF Receiver
Module and SignalShark EMF Monitoring System, R[n].

For more information, please visit our website www.narda-sts.com

SignalShark Handheld SignalShark Remote Unit

SignalShark EMF Monitoring System SignalShark and Narda DF Antennas documentation

s e
o
nardad
Narda Safety Test Solutions GmbH  Narda Safety Test Solutions Narda Safety Test Solutions S.r.l.
Sandwiesenstrasse 7 North America Sales Office Via Benessea 29/B
72793 Pfullingen, Germany 435 Moreland Road 17035 Cisano sul Neva, Italy
Phone +497121 97 320 Hauppauge, NY11788, USA Phone +39 0182 58641
info@narda-sts.com Phone +1 631 231 1700 nardait.support@narda-sts.it
www.narda-sts.com info@narda-sts.com
® Names and Logo are registered trademarks of Narda Safety Test Solutions GmbH — Trade names are trademarks of the owners.
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	Datasheet
	SignalShark 3310
	Real-Time Handheld Analyzer
	Real-Time Handheld Analyzer SignalShark®, for the De- tection, Analysis, Classification and Localization of RF Signals between 8 kHz and 8 GHz. Solves complex measurement and analysis tasks reli- ably and quickly with the same RF performance as com- parable desktop instruments.
	› Frequency range 8 kHz to 8 GHz › Wideband frequency monitoring with an extremely fast
	scan rate of up to 50 GHz/s
	› Covers whole frequency bands with a 40 MHz
	real-time instantaneous bandwidth and a very high frequency resolution › FFT overlap at least 75 % › FFT size: up to 16 384
	› Reliable signal detection due to signal duration with
	100 % POI › > 3.125 μs without attenuation and spectral growth › > 1.41 μs with IQ Analyzer › > 2 ns with attenuation proportional to the spectral
	growth
	› Measures weak signals in the presence of strong
	transmitters with a receiver based High Dynamic Range (HDR)
	› ITU-compliant measurements and applications › Two independent FFT and receiver path allowing signal visualization as well as signal analysis and demodulation at a time.
	› Common used SCPI standard for remote control › VITA 49 streaming (sample rate up to 25.6 MHz)
	allowing storage and post processing of the signal raw data.
	› VITA 49 FFT streaming span up to 40 MHz for over-
	view display
	› High level accuracy

	sales@wavetel.fr
	www.wavetel.fr
	+33(0)2 99 14 69 65
	Take up the frequency spectrum challenges of today and tomorrow
	Spectrum Management Mobile Networks, IoT, M2M/C2C Communication
	TSCM Detection of illegal transmitters and hidden signals
	and many more…
	Area Protection Communication detection next to a boarder or a secret area
	Seven Senses for Signals  Description  Like a Shark, that highly efficient hunter in the ocean, Narda SignalShark derives its success in measurement from the inter- play of its highly developed senses. Its 40 MHz real-time bandwidth captures the spectrum of even very short-pulsed signals > 3.125μs with a POI of 100 %. This guarantees a consistent awareness of all spectrum events. Due to its distinguished analysis functions as real-time spec- trum, spectrogram and persistence, measured signals are ana- lyzed with a very high frequency and time resolution.
	Applications More and more devices have to share the available frequen- cy ranges because of the rapid development in new technolo- gies such as the Internet of Things (IoT), machine-to-machine (M2M) or car-to-car (C2C) communications and expanding 4G/5G mobile networks. Whether making a wideband measurement of an entire fre- quency range, detecting hidden signals, reliably capturing very short impulses or localizing interference signals, SignalShark provides comprehensive measurement solutions for the in- creasingly complex RF spectrum
	sales@wavetel.fr
	www.wavetel.fr
	+33(0)2 99 14 69 65

	Tasks and Views
	Customerapplications have formed the basis for the design of
	the SignalShark family and the layout of the graphical user in- terface (GUI). This is most clearly seen in the concept of Tasks and Views. All SignalShark devices are supporting the same GUI. The devices can be accessed with remote desktop software via a network.
	Tasks
	Measurements often consist of a workflow of several steps, such as locating a signal in the spectrum, measuring its level and analyzing its behavior. This involves switching between dif- ferent measurement modes and settings in each mode when a general-purpose analyzer is used. However, with the SignalShark, the entire measurement work- flow is handled by one or more measurement tasks. These tasks are shown as screen tabs, just like the web pages displayed by a web browser. Each task encapsulates all the measurement parameters and the underlying measurement engine mode. All the measurements in a task are performed at the same time. Up to six measurement visualizations (Views) can be added to adapt a task as required. The SignalShark provides several task modes to support a wide variety of measurement applications.
	Spectrum (Scan) Task
	This task supports measurement of the spectrum over the full frequency span of 8 kHz to 8 GHz in a single measurement at a maximum measurement speed of 50 GHz/s.

	Real-Time Spectrum Task
	Real-Time Spectrum task enables spectrum measurements with a frequency span of up to 40 MHz in real-time. All frequen- cies within the frequency span are acquired simultaneously with no time gaps and with a FFT frame overlap of 75%. The FFT frame overlap increases to 87.5% for frequency spans of 20 MHz or less. A second digital down converter is used at the same time for analyzing and demodulating the IQ data of a sep- arate channel within the 40 MHz real-time bandwidth. The fre- quency and bandwidth of this channel are selectable.

	Auto DF Task
	This task supports the use of the Narda Automatic DF Antenna (ADFA). Each bearing cycle can be as short as 1.2 ms and even the bearings of pulsed signals can be reliably determined as long as the minimum pulse and gap durations are somewhat longer than 2 cycle times. The optional available map and lo- calization functionality, which is integrated into the SignalShark GUI, allows the reliable localization of transmitters. The sophis- ticated state of the art algorithm based on the bearing statistics
	Fig. 1.
	RT Spectrum view (View 1) and Spectrogram view (View 1)
	in a task (Task 2)

	reliably eliminates the influence of false bearings on the local- ization result, as long as there are enough line of sight bearings available from enough locations.

	Real-TimeStreamingTask
	IQ data can be streamed at sample rates of up to 25.6 MHz using the VITA 49 protocol (option). The stream sink can be an external device connected via the LAN interface or a third party application running on the SignalShark itself for deeper analy- sis or decoding of signals.

	IQ Analyzer Task
	IQ Analyzer with 1.6 GB ring buffer, real-time trigger, time do- main analysis and spectrograms with time resolution down to nanoseconds. Up to 1.6 GB of IQ data can be continuously re- corded in a ring buffer. This allows recording of a 40 MHz chan- nel over 5 seconds. Narrower channels can be recorded for a correspondingly longer time. Short-term or sporadic signals can be detected via various trigger functions. The recorded values can be displayed simultaneously as a IQ Spectrum View, IQ Spectrogram View, and a IQ Magnitude View. The special feature here is that it is possible to switch between a high time resolution and a high frequency resolu- tion even after the measurement. This allows a signal to be analyzed in its entire depth. Up to eight markers support the determination of signal parameters.
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	“Time-Gated Measurement” (TGM) function (buit-in in the IQ Analyzer Task) “Time-Gated Measurement” enables signals tobe measured
	at specified time slots. For time division multiplex signals like TDD, where the uplink and downlink are transmitted on the same frequency but at different time slots, the function enables ‘filtering’ to a specific time slot. The time slot can be defined via the Magnitude view. To use the “Time-Gated Measurement” function, the options ‘IQ Analyzer, Recorder, Trigger, Magn. View’ and ‘Spectrogram’ are required.
	“SignalShark 5G Analyzer” (Sk5G) Software  SignalShark 5G Analyzer (Sk5G) is an EMF analysis and mea- surement software for 5G signals in the FR1 band that can be installed on SignalShark. It allows the maximum channel field strength to be extrapolated directly from a 5G traffic signal. To do so, a speed test is initiated on an end device (e.g., smart- phone). This ensures that the base station directs a traffic beam with maximum power at the end device. The beam is captured by the isotropic measuring antenna. The software then records a spectrogram of the traffic signal for each antenna axis, au- tomatically selecting the resource blocks with maximum pow- er, calculating the averaged power per resource element, and then extrapolating to the maximum possible channel power. The measurement takes some seconds and runs mostly auto- matically, significantly reducing the required working time and eliminating the potential sources of error associated with the various mechanical measurements that would be needed using the conventional method. In addition, the software enables an isotropic measurement of the channel power over time to verify the smart power lock function of the base station. To use the software for measurements an isotropic antenna is required. The options ‘Spectrogram’ and ‘SCPI Remote Control’ and the option ‘SignalShark 5G Analyzer Measurement’ must as well be installed on the designated SignalShark. Also need- ed is a 5G-capable device (e.g. smartphone), to create a traffic beam directed to the measurement antenna. With the software alone, without the ‘SignalShark 5G Analyzer Measurement’ option installed, the user can still load and ana- lyze stored measurements to evaluate these measurements.
	Fig. 2.
	Time Gated Measurement function in the IQ Analyzer Task
	Fig. 3. view
	SignalShark 5G Analyzer Software, 5G EMF Extrapolation
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	Views  Measurements are visualized by means of different views. The frequency domain and channel level can be viewed at the same time, for example, by adding a spectrum view and a level meter view to a measurement task. Up to six views can be added to a task. As default each new task opens with a Spectrum view.
	The currently selected view is marked by a blue border. The content and layout of the “Button Bar” to the right, and the “Measurement Information Bar” at the bottom, depends on the currently selected view. The type, arrangement and size of a view can be adapted by the user. It is possible to save the current configuration and arrangement of Tasks and Views into setup files.
	Tasks and Views
	View
	Spectrum Peak Table (of Spectrum) Spectrogram Level Meter Persistence Map Bearing Horizontal Scan
	(zero span, scope)

	IQ Magnitude IQ Spectrum IQ Spectrogram VITA 49 FFT Streaming VITA 49 IQ Streaming 5G EMF Extrapolation 5G ‘Smart Power Lock’ Test
	Spectrum
	(Scan)
	ü ü ü

	Measurement Engine or Task Mode
	RT (Real-Time)
	Spectrum RT RT RT ü RT ü

	Auto DF
	ü ü
	ü ü

	RT
	Streaming

	IQ
	Analyzer
	ü ü ü
	ü ü

	SignalShark 5G Analyzer
	ü ü
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	Device Features
	Options(Views)andScripts
	An extensive setof equipment comprisingfrequency scanner/receiver, transmitter detector, spectrum analyzer, signal analyz- er, directional antennas, amplifier, compass, triangulation software and maps was usually necessary in order to reliably detect, analyze and localize RF signals and interference. The SignalShark combines all these functions in one device.
	Options (Views)
	40 MHz real-time Spectrum, Marker and Peak Table (included in all Basic Sets)
	A Panorama scan display that provides extremely fast scanning over the entire frequency range and is ideal for detecting, monitoring and analyzing any kind of signal. An ideal complement: Mark suspect signals in the spectrum and save them in a transmitter ta- ble with relevant parameters such as center frequency, bandwidth, antenna type, and polariza- tion. This table can then be recalled and worked through successively at each measurement location and in every operating mode of the instrument.

	IQ Analyzer, Recorder, Trigger, Magn. View [option]
	In the IQ Analyzer Task, recorded IQ values can be displayed simultaneously as an IQ Spec- trum View, IQ Spectrogram View and IQ Magnitude View. The special feature here is that it  is possible to switch between a high time resolution and a high frequency resolution even  after the measurement. This allows a signal to be analyzed in its entire depth. Therefore it is  optimal when it comes to detection, analysis and documentations of hop ping signals as well  as of interference signals caused by faulty oscillator, welding systems, defective relays or  lamps, jammers etc. It trigger on short pulsed signals down to ns and has a high time resolu- tion analysis in IQ Spectrogram View and IQ Magnitude View. Up to eight markers support the  determination of signal parameters. “Time-Gated Measurement” function  The “Time-Gated Measurement” function is a built-in key component of the IQ analyzer,  facilitating precise measurement of signals at designated time slots. For time division multiplex  signals, such as TDD, where the uplink and downlink are transmitted on the same frequency  but at different time slots, the function enables targeted filtering to a specific time slot, enabling  effective interference analysis. The time slot can be defined through the Magnitude View,  allowing for precise control over the measurement process.

	Spectrogram [option]
	The Waterfall diagram is ideal for long term monitoring of the RF spectrum and for detecting permanent, sporadic or frequency hopping signals. Transmitters with variable output power and/or bandwidth can also be identified. Visual representation of the recorded spectra versus time. Colors represent the signal level. The smallest selectable time resolution is 31.25 μs. The high resolution makes it possible to display even the frame structures from for services like UMTS, LTE 5G.

	Level Meter incl. Compass values [option]
	The option allows you to make selective measurements at a defined frequency (Fcent) e.g. for monitoring the field strength of a communications channel. The measurement is in real-time and there are no time gaps. The results are shown from an independent receiver path with steep channel filters for clean separation of even closely spaced frequencies and has a CBW range from 25 Hz to 40 MHz for detection and evaluation of pulsed signals (radar) as well as broadband signals.
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	Persistence (of real-time Spectrum) [option]
	The Polychrome spectrum displaysspectra as level versus frequency where color indicates
	rate of occurrence. Persistence allows sporadic to CW (continuous waveform) signals to be detected easily. It can also be described as a visual detection of signal under signal, e.g. a detection of interferers/jammers hidden under a signal.

	Automatic DF Antenna Control, Bearing View [option]
	Aviewfor Direction finding, showingazimuth,elevation,DF quality, and omnidirectional RMS
	level derived from the Narda automatic DF antenna (ADFA). The ADFA elevation is calibrated between +40o und -20o.

	Mapping and Localization [option]
	SignalShark simplifieslocalization of transmitters by autonomously evaluating all the available
	bearing results and plotting them as a heatmap. It uses a statistical distribution of bearing lines that represents the uncertainty in the bearing. The result is a map on which the possible locations of the transmitter are plotted and color-coded according to their probability. Make a drive test using a vehicle mount-adapter, combine bearings from more than 2 Sig- nalSharks (NSL Remote DF) or mount the ADFA 2 180o upside down. There are many fea- tures developed to facilitate and broaden the possibilities for most individual cases. Analog Demodulation [option] for signal identification and decoding. AM, Pulse, CW, ISB, USB, LSB, FM, PM, or IQ signals  can be demodulated with squelch and AGC function. The demodulated signal can be stored  as WAV-file.

	Horizontal Scan [option]
	plots thesignalstrength versus the angle of incidence on a polar diagram. The display allows
	you to more easily see the difference between the received signal and the reflections that occur. The SignalShark automatically calculates the bearing of the signal source based on the horizontally measured values.
	5G EMF Extrapolation,  The5G EMF extrapolation View allows the maximum channel field strength to be extrapolated directly from a 5G traffic signal. A downstream with maximum power is requested using a suitable user equipment (e.g. a  smartphone). The Signal-Shark 5G Analyzer records an isotropic spectrogram and calculates  the average field strength of a 5G resource element as well as the extrapolated maximum  channel field strength. 5G ‘Smart Power Lock’ Test,
	The5G Smart Power Lock test feature measures the isotropic channel power of a given 5G
	channel over an adjustable time and displays this value as a line graph. It also calculates a moving average value that can indicate whether the Smart Power Lock function of the given base station is working correctly. A downstream with maximum power is requested using a suitable user equipment (e.g. a smartphone).
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	SCPI Remote Control [option]
	SCPI(StandardCommandsfor Programmable Instruments) is a language that makes it
	possible to control the SignalShark using standard syntax, command structure and data interchange format. All remote commands are described in Command reference guide for SignalShark The SCPI Remote Control allows the Narda Script Launcher to be installed.

	VITA 49 [option]
	isapacket-based exchange protocol for RF devices. The Vita49 standard provides a commu-
	nications format that is hardware and supplier-independent Shows the basic measurement parameter settings while streaming IQ data according to the Vita 49 standard IQ Data stream can be used for classification, decoding (3rd party SW) of signals.
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	Narda Python Scripts  NSL (NardaScriptLauncher) isa free software from Narda that allows SignalShark users to select and run Python scripts from within the SignalShark application. To control the handheld SignalShark analyzer the “Option, SCPI Remote Control” is required. › Automate routine tasks › Provide guided measurements for novices using message boxes or wizards › Add new measurement evaluation functions › Provide complete measurement automation › New scripts constantly released to be downloaded for free › Possibility to write programs or additions via Python, using a Narda template, customized for specific needs
	NSL Remote DF (NSL Net DF) makes it possible to create a localization with several SignalShark devices in a network.  The user can scan the network to obtain information on all available SignalShark devices,  synchronize all devices with configuration settings of the master device, monitor spectrum re- ception on all devices simultaneously, and use the bearing information to perform localization  on the master SignalShark device.
	NSL Coverage Map
	The user can configure settings for the coverage map and take location-dependent level mea- surements with distinct color-coding. Drive test for coverage, field strength correlated to color scheme

	NSL DF Autopilot
	The function allows the SignalShark to be connected to a navigation system. The coordi- nates determined by the SignalShark heatmap localization are set as target in the navigation  system, thus There is no need to look at the heatmap while driving and only one person is needed.

	NSL Channel Scanner
	A memory/frequency scan that makes it possible to monitor predefined channels in the spec- trum. It is comparable to a channel scan on a radio. If one of the monitored channels exceeds a definable level value, an action (“Action”) previously defined by the user can be executed. It is also possible, to scan a frequency grid. This can be used to create a channel table.

	NSL Limit Line
	enables triggering on signals in the spectrum. The trigger level can be defined by a horizontal line or by a trigger mask. The trigger mask can be created and edited in the settings editor in various ways.


	sales@wavetel.fr
	www.wavetel.fr
	+33(0)2 99 14 69 65
	NSL GNSS displays information about the current GNSS reception and issues a warning message if the quality of the GNSS reception falls below a certain level.
	NSL MS Word takes a Word (.docx) template file as the basis for a measurement report. It reads all settings from the current measurement, makes a screenshot of each view and generates a measure- ment report as MS Word document
	NSL Tools
	NSLCopySettings, copies selectable parameters such as Fcent, RBW and Attenuator from onetasktoanother task. NSLGo2desktop, emulates the Windows-Key + “D-Key” keytroke to go to the Windows desktop NSLSavePeak Table, allows to save the information of a peak table in CSV format. NSLIQStream Control, allows to configure and start an IQ stream easily. NSLPeaktrigger, uses the peak table view of SignalShark to stop the measurement when reachingorexceeding a user defined level. NSLSignalShark WOL, allows to switch on a network connected SignalShark via WakeOn- LAN.

	NSL Converter
	ConvertSignalShark Spectrum Data (from HDF5 (.h5) file format to csv file format) ConvertSignalShark Spectrogram Data (from HDF5 (.h5) file format to csv file format) ConvertIDA (csv-based transmitter tables) to SignalShark (xml-based tansmitter tables) ConvertSRM (csv-based transmitter tables) to SignalShark (xml-based transmitter tables) Converta Template Generated CSV Table (from csv-based transmitter tables to xml-based  transmitter tables)
	NSL IQ Recorder enables the recording of IQ data in WAV format. Allows the user to setup and start/record the IQ streams by using SignalShark SCPI com- mands and save them as an IQ WAV file. The WAV file format is a universal format supported by many monitoring software products and SDR programs.


	sales@wavetel.fr
	www.wavetel.fr
	+33(0)2 99 14 69 65
	Definitions and Conditions
	Conditions Unless otherwise noted, specifications apply after 30 minutes warm- up time within the specified environmental conditions. The product is within the recommended calibration cycle.
	Specifications with limits
	These describeproduct performance for the given parameter cov-
	Typical values (typ.) These characterize product performance for the given parameter that is not covered by warranty. When stated as a range or as a limit (shown as <, ≤, >, ≥, ±, max., min.), they represent the performance met by approximately 80% of the instruments. Otherwise, they rep- resent the mean value. The measurement uncertainty is not taken into account.
	ered by warranty. Specifications with limits (shown as <, ≤, >, ≥, ±, max., min.) apply under the given conditions for the product and are tested during production, considering measurement uncertainty.

	Specifications without limits
	Nominal values (nom.) These characterize expected product performance for the given pa- rameter that is not covered by warranty. Nominal values are verified during product development but are not tested during production.
	These describe productperformance for the given parameter cov- ered by warranty. Specifications without limits represent values with negligible deviations, which are ensured by design (e.g. dimensions or resolution of a setting parameter).
	Uncertainties These characterize the dispersion of the values attributed to the measurands with an estimated confidence level of approximately 95%. Uncertainty is stated as the standard uncertainty multiplied by the coverage factor k=2 based on the normal distribution. The evaluation has been carried out in accordance with the rules of the “Guide to the Expression of Uncertainty in Measurement” (GUM).
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	Specificationsa
	SignalSharkBasicUnit(40 MHz RTBW)
	Frequency Frequency range Scan rate (basic unit, full span) RBW (RT Spectrum) RBW (Scan Spectrum) CBW (Level Meter) EMC filter bandwidth (Spectrum and Level Meter) Detectors (Spectrum and Level Meter)
	CISPR Detectors(LevelMeter)
	SSB  phase noise
	f 10 MHz 1 GHz
	Internal referencefrequency
	8 kHz to 8 GHz > 50 GHz/s 30 GHz/s (typ.) 1 Hz to 800 kHz 1 Hz to 6.25 MHz 25 Hz to 40 MHz 10 Hz, 100 Hz, 200 Hz, 1 kHz, 9 kHz, 10 kHz, 100 kHz, 120 kHz and 1 MHz
	@ RBW = 1.6 MHz (resolution 800 kHz) @ RBW = 100 kHz (resolution 50 kHz)
	+Pk, RMS, -Pk, Avg and Sample
	Cpeak (quasi-peak), CRMS & CAvg (EMC filter with CISPR bandwidth must be selected
	df = 1 kHz < -120 dBc (1/Hz) < -90 dBc (1/Hz) Deviations:
	df = 10 kHz < -130 dBc (1/Hz) < -101 dBc (1/Hz)
	df = 100 kHz < -135 dBc (1/Hz) < -101 dBc (1/Hz)
	< 1 ppm

	df = 1 MHz
	< -112 dBc (1/Hz)

	df = 10 MHz
	< -132 dBc (1/Hz)
	(includes initial deviation, aging within the first 2 years, and temperature response)
	Amplitude HDR (High Dynamic Range)
	DANL (Noise Figure) @ attenuator = 0 dB, no preamp
	2nd order intercept point (IP2, 2 tones) @ attenuator = 0 dB, no preamp 3rd order intercept  point (IP3, 2 tones) @ attenuator = 0 dB,  no preamp
	Level uncertainty Residual spursc @ attenuator = 0 dB
	IF rejection Image rejection
	SignalShark can detect low level signals even in the presence of very strong signals. It does this by combining high sensitivity with a wide intermodulation-free dynamic range. The DANL and IP2 / IP3 values stated below are valid at the same setting.
	1 MHz ≤ f ≤ 44 MHz 44 MHz < f ≤ 3 GHz 44 MHz < f ≤ 3 GHz 3 GHz < f ≤ 8 GHz 4 MHz ≤ f < 42 MHzb  42 MHz ≤ f ≤ 8 GHz
	< - 160 dB (mW/Hz) < - 159 dB (mW/Hz) - 162 dB (mW/Hz) (typ.) < - 152 dB (mW/Hz) > 60 dBm 40 dBm (typ.)
	(resultant noise figure < 14 dB) (resultant noise figure < 15 dB) (resultant noise figure 12 dB) (resultant noise figure < 22 dB)
	3 MHz < f ≤ 44 MHz 3 MHz < f ≤ 44 MHz 44 MHz < f ≤ 630 MHz 630 MHz < f ≤ 3 GHz 44 MHz < f ≤ 3 GHz 3 GHz < f ≤ 8 GHz 3 GHz < f ≤ 8 GHz 9 kHz ≤ f ≤ 8 GHz 8 kHz ≤ f ≤ 44 MHz 44 MHz < f ≤ 3 GHz 3 GHz < f ≤ 6 GHz 6 GHz < f ≤ 8 GHz > 80 dB > 80 dB
	> 20 dBm 26 dBm (typ.) > 4 dBm > 6 dBm 14 dBm (typ.) > 5 dBm 12 dBm (typ.) < ± 2 dB < -120 dBm < -115 dBm < -110 dBm < -105 dBm
	exceptions < -100 dBm exceptions < -100 dBm exceptions < -95 dBm exceptions < -85 dBm
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	Real-Time Spectrum
	Signaldurationfor100% POI
	Spectrum rate FFT overlap

	RF Input
	Type (switchable)
	RF destruction limit Max. nominal RF level Maximum DC voltage Return loss (VSWR)
	Isolation between used and unused inputs
	General Specifications Attenuator Digitizer GNSS
	Internal non-removable memory
	Removable memory External power supply
	Battery
	Inmany countries, the battery is available from several public distrib- utors.
	Dimensions (H x W x D) Weight Country of origin Recommended calibration interval
	RT Spectrum @ RBW = 800 kHz
	IQ Analyzer @ CBW = 40 MHz, RBW = 1.532 MHz and 87.5 % FFT Overlap
	1.6 million spectra / s Fspan > 20 MHz Fspan ≤ 20 MHz, RBW ≤ 400 kHz
	> 3.125 µs without attenuation and spectral growth > 2 ns with attenuation proportional to the spec- tral growth > 1.41 µs with IQ Analyzer
	> 2 ns with attenuation proportional to the spec- tral growth @ RBW = 800 kHz and 75 % FFT Overlap 75 % 87.5 %
	1 x N-connector, 50 Ω (female) 3 x SMA-connector, 50 Ω (female) 20 dBm 15 dBm 25 V 12 kHz ≤ f ≤ 3 MHz 3 GHz < f ≤ 6 GHz 6 GHz < f ≤ 8 GHz 8 kHz ≤ f ≤ 1 GHz 3 GHz 8 GHz
	> 9.54 dB 12 dB (typ.) 10 dB (typ.) 60 dB (nom.) 50 dB (nom.) 35 dB (nom.)
	(VSWR < 2.00) (VSWR = 1.67 (typ.)) (VSWR = 1.93 (typ.))
	0 to 30 dB (0.5 dB steps) 16 bit Embedded receiver and antenna (GPS / QZSS, GLONASS, BeiDou, Galileo) Coordinates representation as decimal degree (DegDec - ddd.ddddd)
	ssD, mSATA
	30 GB system partition  28 GB configuration settings and user data
	microSD (SDXC) / USB 2.0 / USB 3.0 Basic unit, DC input: 10 to 48 VDC AC adapter, input: 100V-240VAC, output: 12VDC, 5.5A Plug type: Non-Locking Power Plug S1017 2 x Lithium-ion rechargeable battery pack, hot-swappable during operation Operating time: approx. 3 hours (typical, with both batteries) Charging time: approx. 4.2 hours (nominal, with both batteries charging in base device) Charging time: approx. 3 hours (nominal, with external charger) 230 mm × 335 mm × 85 mm (9.06ʺ × 13.19ʺ × 3.35ʺ) Approx. 4.1 kg / 9.04 lb (with one battery) Germany 24 months
	Interfaces
	10MHz Reference input PPS/Trigger input GNSS Antenna Input (for additional,  external GNSS antenna) Display Size and Resolution:
	Video Audio
	Ethernet USB (Host) SD card slot
	1 x SMA-connector, 600 Ω (female) 1 x SMA, 100 kΩ (female) 1 x SMA, 50 Ω, female (DC voltage for active antennas is supplied) 10.4‘‘, 1024 x 768 pixels, Color Resistive touch 1 x Display Port 1 x 3.5 mm headphone jack Built-in loudspeaker Built-in microphone 1 x GigE (10/100/1000Base-T), RJ45 1 x USB 3.0, 1 x USB.2.0 1 x microSD-card (SDXC)

	Remote Control and Streaming
	Remote control protocol FFT streaming IQ streaming Remote Software
	SCPI VITA49 compliant VITA49 IQ streaming, sample rate up to 25.6 MHzd Remote Desktop for PC, Tablet and Smartphone (Windows, Android, IOS)

	Additional Functions
	Noisepowerdensity measurement Channel power measurement Occupied bandwidth measurement
	Field strength measurement CISPR Detectors Modulation detectors Frequency offset measurement Analog demodulation and recording
	Tone search
	Automatic DF Automatic transmitter localization  (Heatmap) TDOA localizatione
	Time-Gated Measurement (TGM) 5G ‘Smart Power Lock’ Test
	Can be measured with up to eight markers at a time. Can be measured with up to eight markers at a time. According to ITU-R SM.443-4, with additional automatic center frequency and channel power mea- surement. Can be measured with up to eight markers at a time. According to ITU-R SM.378-7 Cpeak (quasi-peak), CRMS & CAvg (EMC filter with CISPR bandwidth must be selected) AM, FM and PM. Up to 4 different detectors are available simultaneously For CBW ≤ 1 MHz (using modulation detectors) AM, Pulse, CW, ISB, USB, LSB, FM, PM, or IQ signals can be demodulated with squelch and AGC  function. The demodulated signal can be stored as WAV-file. For PIM and interference hunting. The level of one of the detectors modulates the pitch of an audible  tone. Automatic bearing of transmitters using a Narda Automatic DF Antenna. Automatic calculation of the transmitter location.
	Integrated GPS with high-accuracy timestamp for TDOA applications. With additionally available  software package Buit-in in the IQ Analyzer Task. Enables signals to be measured at specified time slots. Calculates a moving average value that can indicate whether the Smart Power Lock function of the  given base station is working correctly.
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	Environmental Conditions
	MIL-PRF-28800F Class 2
	Operating temperature
	Humidity IP class
	Climate
	Storage
	Mechanical
	Compliance EMC
	Transport Operating Storage Transport Operating
	European Union
	Safety Material
	Immunity Emission
	Operating temperature Storage temperature Operating humidity Random vibration Functional shock Transit drop -10 °C to + 55 °C with battery -10 °C to + 55 °C with external power supply 0 °C to + 40 °C with external power supply when charging batteries < 29 g/m³ (< 93 % RH at +30 °C), non-condensing IP 54 (with antenna attached and interface protectors closed) IP 67 (stored in the hardcase) 1K3 (IEC 60721-3) extended to - 20 °C to + 70 °C (batteries removed) 2K4 (IEC 60721-3) restricted to - 20 °C to + 70 °C 7K2 (IEC 60721-3) extended to - 10 °C to + 55 °C 1M3 (IEC 60721-3) 2M3 (IEC 60721-3) 7M3 (IEC 60721-3)
	Complies with RED Directive 2014/53/EU and EN 301 489-1 V2.2.3, EN 301 489-52 V1.2.1 IEC/EN 61326 -1: 2021 IEC/EN: 61000-4-2, 61000-4-3, 61000-4-4, 61000-4-5, 61000-4-6, 61000-4-11 IEC/EN: 61000-3-2, 61000-3-3, IEC/EN 55011 (CISPR 11) Class B Complies with European Low Voltage Directive 2014/35/EU and IEC/EN 61010-1:2010 Complies with European RoHS Directive 2011/65/EU, (EU)2015/863 and EN 63000:2018
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	Ordering Information  The SignalShark Basic Unit is included in theBasic Sets. Application Packages as well as Software Options and Accessories that provideadditional signal analysis capabilities are also available. Your local Narda sales representative can provide information about all the possible options and will be pleased to offer advice.
	Basic Unit Sets
	SignalShark Basic Set
	The Basicset contains the SignalShark as well as basic accessories and supports 40 MHz real-time spec-
	trum analysis, marker and peak table. Includes: › SignalShark 3310/01 Basic Unit › 2x Battery Pack, Rechargeable › Power Supply 12VDC, 5.5A, 100V-240VAC, plug* › Touch pen for resistive touch screen › 40 MHz real-time Spectrum, Marker and Peak Table › Electronic manual (English) › Safety Instructions
	› SignalShark3310 - QuickStartGuide

	Part number 3310/101
	*Please choose Power Cord 2260/90.65 -.69
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	Application Packages
	Theapplication packages make it easy to adapt SignalShark to your requirements. Each package typically consists of applica-
	tion-dependent hardware accessories and/or firmware options, and costs less than purchasing the items individually. Additional packages can be purchased as and when required. Your local Narda sales representative will be happy to assist you in the selection of the right packages for your applications.
	App. Package, Off-Site Extension
	ThisApplication Package provides suitable accessories for applications that involve operation in vehicles or
	outdoors. A hard shell case with wheels and a retractable handle provides secure (IP 67) the transport of the SignalShark and all accessories. The DC adapter enables powering the device from a vehicle. An easily and quickly worn carry strap provides hands-free support for viewing the SignalShark allowing even long-term measurements to be made comfortably. Includes: › Power Supply DC Vehicle Adapter, screw plug (2259/92.12) › Double Charger Set, External for 2259/92.16 (2259/92.17)*

	Part number 3310/94.07
	Consists of:
	2x single bay charger - Charger Set, External (2259/92.14)
	› Vehicle power adapter for charger set 2259/92.17 (2259/92.15)
	Consists of:
	Car/Truck Power Adapter (2259/92.18)  Power Splitter Cable (2259/92.19)
	› Carrying Strap for Basic Unit (3300/90.08) › Headphone, 3.5mm Plug (3300/90.14) › 10.4’’ Screen Protector Film (3310/90.04)
	› Hardcasefor SignalShark 3310 (3310/90.05)


	*Please choose Power Cord 2260/90.70 -.74
	App. Package, Remote Control
	OptionVITA49 requires option SCPI Remote Control for device setup and streaming control. This application
	package makes iteasy to obtain the greatest benefits of SignalShark’s remote control functionality.

	Includes:
	Option, SCPI Remote Control (3310/95.012) Option, VITA 49(3310/95.14)

	›  ›  App. Package, Receiver
	TheReceiver ApplicationPackage guarantees situational awareness by providing gapless analysis of entire
	signalbands. Italsoenablesdemodulation of AM, FM, LSB, USB, and CW signals.

	Includes:
	Option, Spectrogram (3310/95.002) Option,LevelMeterincl.Compassvalues (3310/95.003) Option, Analog Demodulation (3310/95.007)

	›  ›  ›  App. Package, Direction Finding Basic
	ThisApplicationPackage providescomprehensive functions to support hunting of interference signals and
	hidden transmitters. The device based GPS and the antenna handle with built-in electronic compass makes it possible to conveniently take bearings on a transmitter from various locations. Includes: › Active Antenna Handle for SignalShark, 8 kHz to 8 GHz (3300/10) › Arm Support for Active Antenna Handle (3100/90.10) › Option, Mapping and Localization (3310/95.006) › Option, Horizontal Scan (3310/95.011)

	Part number 3310/94.10
	Part number 3310/94.01
	Part number 3310/94.02
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	App. Package, Antenna Basic Kit (Mobile Operators)* This Application Package provides you with a lightweight yet robust directional antenna for the frequency range from 400 MHz to 8 GHz and covers cellular communication as well as other service bands. The Pack- age also includes an antenna adapter that allows you to use your own antennas together with the Antenna Handle. This enables you to benefit from the integrated compass, low noise amplifier, and automatic polariza- tion detector in the handle when using your own Includes: › Directional Antenna 3, 400 MHz to 8 GHz (3100/13) › Antenna Adapter, N Male (3100/15)
	Part number 3106/92.03
	*Additionaloption 3310/95.006 “Mappingand Localization” isrecommended for Open StreetMapbased visualization and heat- map localization as well as the Active Antenna Handle for SignalShark, 8 kHz to 8 GHz (3300/10).
	App. Package, Antenna Extension Kit
	Part number 3106/92.04
	This ApplicationPackage complementsand completes the Antenna Basic Kit Application Package so that you
	can makethe bestuse of the entire frequency rangefrom 8 kHz to 8 GHz.

	Includes:
	Directional Antenna 1, 20 MHz to 250MHz (3100/11) Directional Antenna 2, 200 MHz to 500MHz (3100/12) LoopAntenna,H-Field, 8 kHz to 30 MHz(3100/14)

	›  ›  ›  App. Package, Automatic DF 2, 10 MHz to 8 GHz *
	ThisApplicationPackageprovidesbasicequipmentand options for vehicle based, automatic direction finding
	(bearing). Includes: › Automatic DF-Antenna 2 (3361/01) › USB Stick: Software and Manuals, ordered Options (3310/93.01) › RF-Cable, DC to 8 GHz, N to SMA, 50 Ohm, 5 m (3603/02) › Option, Automatic DF Antenna Control, Bearing View (3310/95.005) › Tool, Allen Wrench 3 mm (3300/90.19) › ADFA Vehicle Mounting Kit for autom. DF Antenna (3300/90.04)
	incl. the “Automatic DF-Antenna Handling and Safety Instructions” multilingual (3360/98.12)
	› Shipping Carton with Inlet for autom. DF-Antenna

	Part number 3310/94.06

	*Additionaloption3310/95.006“MappingandLocalization”isrecommendedforOpenStreetMapbased visualization and heat- map localization.
	App. Package, Automatic DF 2, 10 MHz to 8 GHz, Hardcase *
	ThisApplicationPackageprovidesbasicequipmentandoptionsfor vehicle based, automatic direction finding
	(bearing). Includes: › Automatic DF-Antenna 2 (3361/01) › USB Stick: Software and Manuals, ordered Options (3310/93.01) › RF-Cable, DC to 8 GHz, N to SMA, 50 Ohm, 5 m (3603/02) › Option, Automatic DF Antenna Control, Bearing View (3310/95.005) › Tool, Allen Wrench 3 mm (3300/90.19) › ADFA Vehicle Mounting Kit for autom. DF Antenna (3300/90.04)
	incl. the “Automatic DF-Antenna Handling and Safety Instructions” multilingual (3360/98.12)

	Part number 3310/94.12
	› Hardcase for Automatic DF Antenna (3360/90.01)


	*Additionaloption3310/95.006“MappingandLocalization”isrecommendedforOpenStreetMapbased visualization and heat- map localization.
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	Software Options
	Softwareoptionsallowthe adaption of the device feature set to your needs.
	Description 40 MHz real-time Spectrum, Marker and Peak Table (included in SignalShark 3310 Basic Set). Via the “Spectrum (Scan)”-, “RT (Real-Time) Spectrum”- “Auto DF”-, and “IQ Analyzer”-Tasks, the following  View(s) can be accessed:
	› Spectrum View › Peak Table (of Spectrum) View
	Part number Included in Basic Set
	Option, Spectrogram Via the “Spectrum (Scan)”- and “RT (Real-Time) Spectrum”-Tasks, the following View(s) can be accessed:
	› Spectrogram View

	3310/95.002
	Option, Level Meter incl. Compass values Via the “RT (Real-Time) Spectrum”-Task, the following View(s) can be accessed:
	› Level Meter View

	3310/95.003
	Option, Persistence (of real-time Spectrum) Via the “RT (Real-Time) Spectrum”-Task, the following View(s) can be accessed:
	› Persistence View

	3310/95.004
	Option, Automatic DF Antenna Control, Bearing View Via the “Auto DF”-Task, the following View(s) can be accessed:
	› Bearing View

	3310/95.005
	Option, Mapping and Localization Via the “Spectrum (Scan)”-, “RT (Real-Time) Spectrum”-, and “Auto DF”-Tasks, the following View(s) can be  accessed:
	› Map View › Heatmap

	3310/95.006
	Option, Analog Demodulation (see ”Additional Functions” on page 14)  Via the “RT (Real-Time) Spectrum”-Task, the following View(s) can be accessed:
	› Spectrum View › Level meter Viewf

	3310/95.007
	Option, Horizontal Scan  Via the “RT (Real-Time) Spectrum”-Task, the following View(s) can be accessed:
	› Horizontal Scan View

	3310/95.011
	Option, SCPI Remote Control Option, VITA 49g  Via the “RT Streaming”-Task, the following View(s) can be accessed:
	› VITA 49 FFT Streaming View › VITA 49 IQ Streaming View

	3310/95.012 3310/95.014
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	Description
	Option, IQAnalyzer, Recorder, Trigger, Magn. View

	Part number 3310/95.018
	Via the “IQ Analyzer”-Task, the following View(s) can be accessed:
	› IQ Magnitude View › IQ Spectrum View › IQ Spectrogram View
	“Time-Gated Measurement” function is a built-in key component of the IQ analyzer, facilitating precise mea- surement of signals at designated time slots. Option, SignalShark 5G Analyzer Measurementh Via the “SignalShark 5G Analyzer”-software, the following View(s) can be accessed:
	› 5G EMF Extrapolation View › 5G ‘Smart Power Lock’ Test View

	3310/95.020
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	Accessories
	Accessory Description
	Part number 2259/92.09
	Power Supply 12VDC,5.5A, 100V-240VAC, Non-Locking Power Plug S1017, choose Power Cord 2260/90.65 -.69 Power Supply DC Vehicle Adapter, screw plug Battery Pack Set, rechargeable, Li-Ion, 2 x RRC2057, Li-Ion, 7V5 , 6.4Ah Double Charger Set, external, for 2259/92.16, choose Power Cord 2260/90.70 -.74

	2259/92.12 2259/92.16 2259/92.17
	Consists of:  Vehicle power adapter for charger set 2259/92.17
	2x single bay charger - Charger Set, External (2259/92.14)

	2259/92.15
	Consists of:
	External GNSS Antenna, active Touch pen for resistive touch screen Carrying Strap for Basic Unit RF Adapter, N Male to SMA Female, 50 Ohm Headphone, 3.5mm Plug for SignalShark Hardcase for SignalShark 3310 Recovery media for SignalShark Quad Core 10.4’’ Screen Protector Film Tripod, Non-Conductive, 1.65 m, 1/4”, with Carrying Bag Tripod, Non-Conductive, 1.65m, reinforced, 3/8”-16 UNC (for ADFA 2 only) Tripod Quick-Release Coupling, 3/8”-16 UNC (for 3300/90.16) ADFA Non-Conductive Antenna Mast Mounting Kit RF and Control-Cable for Automatic DF-antennas, DC to 8 GHz, N to SMA, 50 Ohm, 5 m RF and Control-Cable for Automatic DF-antennas, DC to 8 GHz, N to SMA, 50 Ohm, 15 m RF and Control-Cable for Automatic DF-antennas, DC to 8 GHz, N to SMA, 50 Ohm, 10 m
	Car/Truck Power Adapter (2259/92.18) Power Splitter Cable (2259/92.19)

	3300/90.05 3300/90.07 3300/90.08 3300/90.13 3300/90.14 3310/90.05 3310/90.25 3310/90.04 2244/90.31 3300/90.16 3300/90.17 3300/90.23 3603/02 3603/03 3603/07 Part number 3100/11 3100/12 3100/13 3100/14 3100/15 3100/90.10 3300/10 3361/101 3502/03
	Antennas* Directional Antenna 1, 20 MHz to 250 MHz Directional Antenna 2, 200 MHz to 500 MHz Directional Antenna 3, 400 MHz to 8 GHz Loop Antenna, H-Field, 8 kHz to 30 MHz Antenna Adapter, N Male for Handle 3100/10 and 3300/10 Arm Support for Active Antenna Handle Active Antenna Handle for SignalShark, 8 kHz to 8 GHz Automatic DF-Antenna 2 Basic Set, 10 MHz to 8 GHzi Antenna, Three-Axis, E-Field, 200 MHz to 8 GHz

	*ThereisaseparateDFantennadatasheet,whichprovides detailed information about the direction-findingantennas available
	from Narda.
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	SignalShark Family
	There areseveraldifferentinstrument types in the SignalShark family:
	SignalShark Handheld, SignalShark Remote Unit, SignalShark Outdoor Unit Modem R[n] Basic Set, SignalShark DF Receiver Module and SignalShark EMF Monitoring System, R[n]. For more information, please visit our website www.narda-sts.com
	SignalShark Handheld
	SignalShark Outdoor Unit
	SignalShark EMF Monitoring System
	SignalShark Remote Unit
	SignalShark DF Receiver Module
	SignalShark and Narda DF Antennas documentation
	Narda Safety Test Solutions GmbH
	Narda Safety Test Solutions
	Narda Safety Test Solutions S.r.l.
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